Clarinet
Executable Test Script Training

Packet Data Systems Ltd
The Wharf, P. O Box 48
Pangbourne
Berkshire, RG8 7EG
United Kingdom

Tel: +44 (0)118 9845944
Fax: +44 (0)118 9844559
e-mail: info@pds-test.co.uk
website: www.pds-test.co.uk

Table of Contents

Clarinet Executable Test Suites.......................................................................................................................... 3
The Acacia TTCN Compiler............................................................................................................................. 3
Software Installation: Clarinet ETS..................................................................................................................... 4
Security Key ......................................................................................................................................................... 5
To install the security Key................................................................................................................................ 5
Determining the Security Key’s Current Authorisation .................................................................................. 5
Samples of ETS Result Traces........................................................................................................................... 5
Editing an ETS Profile ......................................................................................................................................... 6
Example Using TBR4L3 ...................................................................................................................................... 7
Test Case List Selection .................................................................................................................................. 8
PICS/PIXIT Parameter Selection........................................................................................................................ 9
Selective Expression ......................................................................................................................................... 10
Running an ETS Profile..................................................................................................................................... 10
Automatic IUT Status Checks ........................................................................................................................... 10
Creating a Display Filter.................................................................................................................................... 11
To Edit a Recorded Event ................................................................................................................................. 13
To Print a Recorded Event File......................................................................................................................... 13
The Clarinet TTCN-HTML Display Tool ........................................................................................................... 14
The DEFS Directory....................................................................................................................................... 14
Jumping from the Clarinet Event-Editor to HTML Pages................................................................................ 15
Executable Test Suite Report Generator ......................................................................................................... 16
Installation....................................................................................................................................................... 16
Operating Instructions.................................................................................................................................... 16
Generating the Report from the text file ....................................................................................................... 17
Detailed Instructions on Completing the Dialog Boxes ............................................................................... 18
Modifying the Test Report Template............................................................................................................. 23

2

Clarinet Executable Test Suites
The table below shows a summary of the test suites currently available:-

ISDN User

TBR003 Layer 2, TBR003 Layer 3, TBR004 Layer 2, TBR004
Layer 3, TBR008, TBR033 Layer 2, TBR033 Layer 3, TBR034
Layer 2, TBR034 Layer 3, 3PTY, CCBS, AOC, CDIV, CLIP, CLIR,
COLP, COLR, CONF, CUG, CW, DDI, ECT, MCID, MSN, MWI,
SUB, UUS, Basic Call. NIUF Test Suites also available.

ISDN Network

ETS300*** including: Data Link (Layer 2), Basic Call, 3PTY, AOC,
CCBS, CCNR, CDIV, CLIP, CLIR, COLP, COLR, CONF, CUG,
CW, DDI, ECT, HOLD, MCID, MSN, MWI, SUB, UUS, VPN Basic
Call.

QSIG

QSIG Basic Call and GFP

V5.1

Data Link Layer, Network AN Side, Network LE Side
(edition 2 also available).

V5.2

Data Link Layer, Network AN Side, Network LE Side
(edition 2 also available).

SS7

INAP-CS1, ISUP-V2 Supplementary Services, ISUP-V2 Basic
Call, MTP2, MTP3, SCPP, TCAP.

ATM

AF-Test 00041, AF-Test 00060, ATM SSCOP, UNI Basic Call
Network Side, ATM UNI Point/Multipoint.

Frame Relay

PVC and SVC.

X25

X25 Layer 2 DTE - ISO
X25 Layer 3 DTE - ISO

NMDS

Layer 3 NTN-Side

An up to date list of available ETS can be found on the PDS website: http://www.pds-test.co.uk/conformance_directory.html

The Acacia TTCN Compiler
Acacia, the manufacturers of the Clarinet system have been involved with conformance testing since 1992
and their first task was to develop a TTCN compiler. The TTCN compiler is used to generate Executable
Test Scripts (ETS) that are available for customers ready to run on their Clarinet system.
The Clarinet TTCN compiler is available to purchase for those customers who wish to modify the
behaviour of a test script or to generate new scripts that are not available as Acacia ETS.
The compiler creates a C program controlling the behaviour of the Clarinet at any layer or layers tested by
the script. Other layers are automatically managed by the Clarinet Run-time software. TTCN compiler
technical support is provided directly by the Acacia Protocol Centre in Sophia Antipolis, France.
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Software Installation: Clarinet ETS
1.
2.

3.
4.
5.
6.
7.

Insert the Clarinet Run-Time CD which will Auto Start.
In the second table each Executable Test Suite is listed together with the part numbers used by
PDS/Acacia. The part numbers for the ETS you have ordered are clearly highlighted on the PDS
delivery note, order acknowledgment and invoice.
Identify the ETS you want to install.
For more information on the status of the ETS click on the INFO hyperlink.
To install the ETS click on the INSTALL hyperlink.
Select to run the program from it’s current location.
The ETS will install.

The installation of Clarinet ETS creates the directories Claets and one subdirectory for each ETS under
the path selected during installation (default: C:\Clarinet).
Each ETS sub-directory installed on the PC includes all tools necessary to run the ETS:•
•
•
•
•
•
•

Test case list files (.tda)
PICS/PIXIT files completed with standard parameters (.pia)
Documentation files (Word 7.0 and Acrobat format).
ETS_ope: provides information about the ETS operation (template files, profiles….)
ETS_ref: provides information about the ETS reference (ATS origin).
IUT profiles, filters to run the clarinet.
Object files allowing modification of the ATS and the ability to compile using the Clarinet TTCN
development package:
o Custom.obj
o Userop.obj
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Security Key
The Clarinet ETS and Clarinet DEV-TTCN require the installation and authorisation of the Clarinet security
key.

To install the security Key
IMPORTANT - Upon receipt of the Acacia Security Key, you must fill in and fax back to Acacia the
product registration form which includes a request for passwords section.
1.
2.
3.
4.
5.

Once you have the passwords, connect the security key to the parallel port of your host PC.
From Windows Explorer find Wractive.exe which will be found in C:\Clarinet\Clatools.
Double click on Wractive.exe.
A window will open prompting you to enter the password supplied by Acacia.
Enter the passwords and click Apply.

Determining the Security Key’s Current Authorisation
1.
2.
3.

From Windows Explorer find Wractive.exe which will be found in C:\Clarinet\Clatools.
Double click on Wractive.exe.
Click on Show Authorisation to view the serial number of the security key and all currently
authorised products.

Samples of ETS Result Traces
The directory named RUN provided with each ETS on the Clarinet Run-Time CD, contains Clarinet Event
files. These files have been created by Acacia who have run the ETS in front of standard IUT. They
provide some help to customers who wish to see the TTCN trace and PDU exchange. A filter (.acf) is
also generally included and this together with the event file (.ace) can be copied from the RUN folder on
the CD ROM and then pasted into your working Clarinet directory (cladata, claets or own folder). The
event file may be viewed and filter applied using the Clarinet Event Editor in the usual way.
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Editing an ETS Profile
While using the Clarinet for basic simulation and analysis you will be working in the C:\Clarinet\Cladata
directory which contains all the profiles and filters for these functions.
In order to run the conformance test software the first step is to change the working directory to
C:\Clarinet\Claets.
This is achieved by clicking on Directory in the Clarinet-Manager Dialog 1 window.
You will see that it shows Cladata as the default directory and a list of profiles, events and filters
contained in this folder.
Click on the
icon to go up one level. This will take you to the Clarinet directory and you will see that
this contains three folders: Cladata, Claets and Clatools. Double click to select Claets to see folders for
each of the ETS conformance packages that have been installed onto your system.

Choose one of these by double clicking it and then click on select. You will now have returned to the
Clarinet-Manager Dialog 1 window and you can click on the far left hand icon to edit a profile in exactly the
same way as it works for simulation.
Click on to see the profiles that are available. Usually one or two tests will be provided that will test the
status of the IUT and then one, which has been pre-configured to test a device using typical PICS/PIXIT
parameters and the full list of test cases. This is provided so that you can see examples of what is
required and in what format, before any test suite is executed.
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Example Using TBR4L3
Select TBR4L3 from the Claets folder as described in the ETS profile.
Click to edit the profile TBR4-tel.acp (if you need to select CRC4 click on options under the Clarinet
interface and click in the box to select CRC4).
Now click on TTCN User Program and this will open the TTCN Signalling User Program window. In
this window you will notice the program name (.exe) for the TBR4L3 test suite and the file names
containing the test case list (.tda) and PICS/PIXIT parameters (.pia).
From this window it is also possible to change the delay before the first test case is executed and then the
delay between each subsequent test case. This allows the user to slow down the speed of execution if his
IUT needs time to reach a stable state.
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Test Case List Selection
Click Edit next to Test Descriptor file to open the TBR4L3.tda test case list file. By default, all test
cases are selected and the cursor is positioned over the first test case which is TC10002. A description of
the purpose of TC10002 is shown in the Purpose window and if you click the mouse pointer to select a
different test case, you will see that each one has it’s own purpose explained in this way.

As an exercise, click Unselect in the Action area. Now click All to deselect all the test cases.
Highlight the first test case and look in the Group area (at the top of the window) where you will see the
indication: U00/PS/TC10002. This is the group number and you can click to select each individual test
case down to TC20002 before the group changes from U00/ to U01/.
The certified test laboratories usually test one group at a time and this can be achieved easily with the
Clarinet system as detailed below.
First click Select in the Action area. Now click Group and type in U00/ followed by OK. Immediately
you will see that the first 14 test cases become selected.
Use the same method to select group U01/, U02/ and so on.
Alternatively, you can highlight any individual test case and manually select or de-select it by clicking on
Select at the bottom of the list (bottom right hand corner).
Other selection mechanisms include the Test Case Name, part of the Purpose (for example type
“RELEASE” and see that all the test cases with a purpose including the word RELEASE become
selected), or the Configuration (if specified).
The selection process allows the user to choose test cases from a particular group or those that test a
particular function, which is very useful.
After you have chosen the most suitable range of test cases for your testing, you can save this list under a
new name for inclusion in any profile by clicking on Save As and entering a name with a .tda extension.
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PICS/PIXIT Parameter Selection
From the TTCN Signalling User Program window click Edit next to PICS/PIXIT file to open the
TBR4_TEL.pia PICS/PIXIT parameter file.
By default the cursor is positioned over the first parameter BDL. A description of the purpose of this
parameter is shown in the Purpose window, and you will see that it is: TRUE if broadcast data link is used.
Below the purpose window there is a Value window and an indication of the mode of selection, which in
this case is Boolean.
The value shown by default is “0” which identifies that broadcast data link is not used. If it is used on the
IUT then simply replace the 0 with a 1 and the statement now becomes TRUE.
Use the mouse pointer and click to select other parameters in the list to see their purpose and the default
value.

Some parameters such as BCAPV (Bearer Capability Valid) are in a hexadecimal mode so the required
value needs to be entered in HEX.
In the TBR4L3 example, the default value is 04 03 80 90 a3, which is the information element code (04),
followed by the information length (03 = 3 octets), followed by the information itself (80 90 a3 – A standard
“speech” call).
A standard data call has the hex code 88 90, which is just two octets, so to change the Bearer Capability
Valid value accordingly, use the same information element code (04), followed by the change in
information length (02 = 2 octets), followed by the change in information itself (88 90 = A standard data
call).
So, to specify that a valid bearer capability used whilst testing your IUT should be a standard data call,
change the value from 04 03 80 90 a3 (default) to 04 02 88 90.
The developers of the IUT will always have access to the required PICS/PIXIT parameters to enable
relevant testing, and it is usually a matter of obtaining these and then entering them one by one into the
Clarinet PICS/PIXIT editor.
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Once entered, the required values for each IUT can be saved in a new file by clicking Save As, entering a
new name and using the extension .pia.

Selective Expression
The Clarinet system uses the latest TTCN compiler which includes the function of selective expression to
simplify configuration. Selective expression looks through the PICS/PIXIT parameters that have been
entered for the IUT and automatically de-selects any test cases that are not relevant even if the test case
has been previously selected by the user. In the verdict list added to the end of each event file there are
two columns, one to identify which test cases were selected and the other to identify whether or not they
were executed. These columns help you identify which test cases are relevant to your IUT based on
PICS/PIXIT parameters entered and may help to debug the configuration for your equipment which will
prove useful.

Running an ETS Profile
Once the conformance test script profile has been edited to contain a list of the test cases and PICS/PIXIT
parameters applicable to the IUT, running it is very simple.
Using the Clarinet-Manager Dialog 1 window, click on
profiles available and select the one that you wish to run.

now click on the down arrow to see all the

Click OK to run the profile and the event trace containing all test stages and protocol messages
exchanged will open together with a status window indicating the start of each test case and the verdict.
PICS/PIXIT parameters used will be automatically inserted at the start of the event trace and a summary
of the verdicts will be inserted at the end so that all relevant information is contained in just one file.

Automatic IUT Status Checks
Before the actual test script starts the Clarinet is often pre-configured to test the IUT in order to ensure
that it is in the correct state before execution of the script. This is to reduce the number of unexpected
‘failed’ verdicts that will appear if the IUT is not ready.
For example, if you are running an ISDN conformance test script such as TBR4L3, the Clarinet will bring
up Layer 2 and then automatically send an empty setup message to the IUT. If the IUT is ready to accept
a setup message it will notice the missing Information Element contents and respond with a RELEASE
COMPLETE using a cause value of 96 – Mandatory IE is missing.
These basic tests have been linked to the ETS profile but are also included independently in the list of
profiles available when any test script is installed. For example, with TBR4L3 the automatically installed
test profiles include IUT (used for testing the basic IUT configuration) and INIT (used to test that Layer 2 is
active and the IUT is ready to accept Layer 3 messages).
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Creating a Display Filter
A display filter used with any protocol event file may be opened and modified by clicking on the

.

icon at the top of the event file (in a real time display or off line display). Alternatively, click
in the
middle of the Clarinet-Manager Dialog 1 window and select the name of the filter that you wish to modify.
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There are five tabs along the top of the filter editor but the most important for conformance testing are the
second and the fifth tabs. The second tab is called ‘Event Display’ and allows removal of unwanted
protocol layers and to change the colours (attributes) of the protocol messages transmitted or received.
The fifth tab is called ‘TTCN’ and defaults to all options being selected but if required you can deselect
certain verdicts, detail and events from the display. It is also possible to change ETS foreground and
background attributes so that the display looks exactly as required.

The maximum detail default selection will show all the TTCN stages interleaved with all protocol
messages as they arrive or leave the interface pod. This is useful because it allows the user to see
exactly how far the IUT progressed through the test before any problems occurred. If preferred, separate
windows can be opened each containing pre-selected levels of information by applying different user
created filters to the same event file.
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To Edit a Recorded Event
1.

From the Clarinet-Manager Dialog – 1 window click on the fourth Icon from the right to open a
protocol event file.

2.

Select the required Events and Filter files. Click on OK.

3.

Your file will be displayed for you to scroll up and down and by using the
for any verdict such as passed, failed or any matching text in the event file.

icon you can search

To Print a Recorded Event File
Once the event has been opened on the display:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

The cursor should be placed at the start of the trace – Press the ‘Home’ key
Select the Edit menu.
Select Copy ASCII.
Place the cursor at the end of the trace – Press the ‘End’ key.
Select the menu Edit.
Select Copy ASCII.
An ASCII Clipboard Save As dialog will be displayed.
Select a location and name for the file – the file extension should be ‘.txt’.
Click Save. The file will be saved in C:\Clarinet\Claets directory.
The .txt file may now be opened and printed from Wordpad etc.
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The Clarinet TTCN-HTML Display Tool
This tool allows the user to view the ATS (Abstract Test Suite) in Html format which is useful when
analysing the results of ETS execution.
The tool splits a TTCN ATS into HTML pages enabling:•
•

The ability to view the TTCN ATS with any HTML explorer.
The ability to jump directly from the Clarinet Event Editor to the TTCN ATS.

The DEFS Directory
When you install your ETS (see installation instruction on page 4) the installation procedure creates a
directory dedicated to each ETS under \claets. The HTML pages are located in the Defs sub-directory of
each* ETS directory.

The window above shows the Defs subdirectory in the Claets\403-5 directory.
* The Clarinet ETS CD-ROM only includes the DEFS directory’s for the latest ETS to be developed.
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Jumping from the Clarinet Event-Editor to HTML Pages
The Clarinet Event-Editor displays the TTCN traces which are merged with protocol events when
executing the ETS.
By clicking the right button of the mouse, a Go To… command is available to jump to the TTCN definition
selected on the Event Editor screen.
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Executable Test Suite Report Generator
Introduction
This tool generates a Protocol Conformance Test Report from an Acacia protocol trace. It consists of a
pair of template files for Microsoft Word 97, one of which contains a Visual Basic macro.

Installation
This tool consists of two files:Generate a Test Report.dot
ReportTemplate\ReportTemplate.dot
These files are supplied on the Clarinet Run-Time CD in the Tools directory. The templates can be
found in the Report folder. If you are using Word 2000 the templates can be found in the Report2000
folder.
1.

The file 'Generate a Test Report.dot' and the sub-directory 'ReportTemplate', and contents
should be copied into a directory specified in Word for either User Templates or Workgroup
Templates.

2.

To find the location for these templates: Start Word, select the Tools menu, select Options,
Click the File Locations tab. The entries User Templates and Workgroup Templates should be
displayed.

3.

Copy the templates into this location (remember if you are using Word 2000 copy the templates
within the Report2000 folder).

Operating Instructions
The TTCN tab within the protocol filter should have the following options selected:Detail Events – Test Case
Detail Events – Test Step
Detail Events – Default Library
Detail Events
The protocol filter (.acf file) delivered with the suite has all the appropriate options selected.
Once the test suite has finished running:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

The protocol trace file should be opened with the Clarinet-Manager.
The cursor should be placed at the start of the trace – Press the ‘Home’ key
Select the Edit menu.
Select the menu entry Copy ASCII.
Place the cursor at the end of the trace – Press the ‘End’ key.
Select the Edit menu
Select the menu entry Copy ASCII.
An ASCII Clipboard Save As dialog will be displayed.
Select a location and name for the file – the file extension should be ‘.txt’.
Click Save. The file will be saved in C:\Clarinet\Claets directory.

16

Generating the Report from the text file
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Open Word.
Select the File menu.
Select New.
Select the General tab.
Select the Generate a Test Report.dot icon. Ensure that Create a New Document is selected.
Click OK.
An Open file dialog will be displayed. Select the file saved in step 9 above.
Click OK. It may take some time to process the text file!
A tabbed dialog box will be displayed. Complete the fields, (for further details, see following
pages).
When all the fields have been completed click Done.
The file may now be saved or printed as you would any Word document.

If Macro Virus Protection is enabled a warning may be displayed – this is normal: enable the macro or the
tool will not run. This is not a virus!
Note – this tool can generate large files!
The text file and resultant Word document can be quite large. The size is dependent upon the number of
test cases contained in the test suite. Six hundred tests will result in a 2000 page test report that will be
saved as an 18MByte Word file. This text file will require about 13MBytes of space and the tool requires
the same amount of disk space as the text file, as workspace – this is freed after the tool has finished.
In-order to speed up the operation of the tool it is recommended that the text file should be stored and
operated from the local hard-drive.
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Detailed Instructions on Completing the Dialog Boxes
The main dialog box consists of a number of tabbed pages. The tabs correspond to the sections of the
ETSI ‘New Regime’ Protocol Conformance Test Report. As the fields are completed the corresponding
sections of the document are completed. Some fields are automatically completed from the data in the
protocol trace file; for example, below the field ‘PCTR date’ has been extracted from the file. If these
suggestions do not correspond to the correct information these fields can be edited.
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Some pages contain large text boxes to allow extensive information to be entered. To start on a new line
press the ‘Shift’ + ‘Enter’ combination. If the text fills the text box scroll bars will be displayed to allow the
text to be easily edited.
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Some pages have a Boolean choice, select the option that corresponds. The text is taken directly from the
relevant paragraphs in the ETSI proforma. Caution - some contain a double negative, for instance the
following example!
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This page allows the insertion of a brief test report, by clicking Insert Test Campaign Report. This is in the
form of a table with one line per test, as found at the end of a test campaign.
Insert Test Cases opens another dialog box ...
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With this dialog box the full traces of the test cases can be included in the test report. Only those test
cases in the right hand box will be included in the test report. To simply include the full traces for all the
test cases click All. To select individual test cases (for example only those tests which failed) select the
name of the test case and click the right arrow. In case of error an entry in the right hand box can be
returned to the left hand box using the left arrow. Double clicking an entry will move that entry to the
opposite box. Multiple entries can be selected by using the shift and control keys.
Test cases will be inserted in the order in which they appear in the right hand text box – entries are added
to the bottom of the list.
When all the test cases whose complete details are required in the report have been added to the right
hand box click Insert...
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Modifying the Test Report Template
The tool employs a template to generate the report. The default template is based on the ETSI proforma
found in Annex A of the ‘New Regime’ ATS.
This template can be fully modified by the user to suit their requirements.
The name of the template must be ReportTemplate.dot and it must be found in the a sub-directory called
ReportTemplate. The template (containing the Visual Basic source for the tool) ‘Generate A Test
Report.dot’ must be found in the parent directory. These should be found on one of the paths that Word
uses to find its templates – this is described on page 16.
The Visual Basic program behind this template completes the template by searching for bookmarks and
inserting text at these points. A replacement template should therefore include these bookmarks. The
program will still function if some of these bookmarks are not present.
This is a list of the Bookmarks that should be included in the Template:
APC_Abstract_test_method
APC_ATS_Spec
APC_Comments_Begin
APC_Comments_End
APC_Conf_log_refs
APC_Conformance_status †
APC_Dates_of_testing
APC_Dynamic_conf_summary_details_begin
APC_Dynamic_conf_summary_details_end
APC_Dynamic_conformance_summary †
APC_Limits_and_reservations_begin
APC_Limits_and_reservations_end
APC_Means_of_testing_id
APC_Name
APC_Observations_begin
APC_Observations_end
APC_PCTR_date
APC_PCTR_number
APC_PICS
APC_PIXIT
APC_PIXIT_ref_number
APC_Previous_PCTRs
APC_Protocol_Specification
APC_Report_author_begin
APC_Report_author_end
APC_Report_title_begin
APC_Report_titie_end
APC_Retention_date_for_refs
APC_SCTR_date
APC_SCTR_number
APC_Static_conformance_report_begin
APC_Static_conformance_report_end
APC_Static_conformance_summary †
APC_Test_campaign_report
APC_Test_cases
APC_Test_lab_id
APC_Test_lab_manager
APC_Version
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The bookmark pairs ending with “begin” and “end ” should be present in pairs with paragraph marks
between them. (Clearly the “begin” should be before the “end”!)
† These bookmarks are for Boolean choices (is/is not, does/does not, has/has not) and should precede
the first of these choices.

Specifications subject to change without notice.
 Packet Data Systems Ltd 2001.
Issue 1.0 – August 2001.
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